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MobileHMI Getting Started License Agreement

ICONICS LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING
TERMS AND CONDITIONS!

Opening and using the enclosed software for any purpose indicates your
acceptance of the terms and conditions of this license agreement. If you do not
agree with them you should return all software, documentation and copy
protection keys within seven days of shipment unopened and your money will be
refunded.

ICONICS provides this program and licenses its use in the United States, Puerto
Rico, or internationally. You assume the responsibility for the selection of the
program to achieve your intended results, and for the installation, use and results
obtained from this program.

LICENSE

You are granted a personal license to use this program under the terms stated in
this Agreement. You may: 1) Install and use the program on a single machine;
and 2) make a single archival back-up copy of the program for the sole purpose
of supporting your use of the single program on a single machine. You may not
copy, translate, modify or adapt the program, or any portion thereof, or
incorporate it, in whole or any part, in any other product, create derivative works
based on the program, or any portion thereof, or license others to reproduce any
copies of the program, or any portion thereof, and you may not decompile,
disassemble or reverse engineer the program, or any component thereof except
as permitted by law, and then only after having prior requested in writing from
ICONICS any interoperability information you are attempting to obtain.

TERM
The license is effective until terminated. It will terminate if you fail to comply with
any term or condition of this Agreement. You agree, upon such termination, to
destroy the program and all copies that were made from it and to promptly return
any copy protection key(s) to ICONICS.

LIMITED WARRANTY

ICONICS WARRANTS THE CD-ROM, DVD OR PHYSICAL DISKETTES, ON
WHICH THE PROGRAM IS FURNISHED, AND PHYSICAL DOCUMENTATION
TO BE FREE OF DEFECTS IN MATERIALS AND WORKMANSHIP UNDER
NORMAL USE FOR A PERIOD OF NINETY (90) DAYS FROM THE DATE OF
DELIVERY TO YOU AS EVIDENCED BY YOUR RECEIPT. THIS PROGRAM IS
PROVIDED “AS 1IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE
QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD
THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF
ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.

ICONICS it
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ICONICS SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES,
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED
WARRANTIES OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN PARTICULAR, WITH RESPECT
TO ANY PARTICULAR APPLICATION, USE OR PURPOSE, IN NO EVENT
SHALL ICONICS INC. BE LIABLE FOR ANY OTHER COMMERCIAL DAMAGE,
INCLUDING BUT NOT LIMITED TO  SPECIAL, INCIDENTAL,
CONSEQUENTIAL OR OTHER DAMAGES. ICONICS DOES NOT WARRANT
THAT THE FUNCTIONS CONTAINED IN THE PROGRAM WILL MEET YOUR
REQUIREMENTS OR THAT THE OPERATION OF THE PROGRAM WILL BE
UNINTERRUPTED OR ERROR FREE.

LIMITATION OF REMEDIES

ICONICS’ entire liability and your exclusive remedy shall be the replacement of any
CD-ROM, DVD or diskette not meeting ICONICS’ “Limited Warranty” which is returned
to ICONICS with a copy of your receipt within the warranty period. The remedy for
breach of this warranty shall be limited to replacement and shall not encompass any
other damages including but not limited to loss of profit, special, incidental,
consequential, or other similar claims arising out of the use or inability to use such
program even if ICONICS has been advised of the possibility of such damages, or for
any claim by any other third party.

GENERAL
This Agreement will be governed by the laws of the Commonwealth of Massachusetts.
Should you have any questions concerning this Agreement, you may contact ICONICS
in writing at:

ICONICS, Inc.
100 Foxborough Boulevard
Foxborough, MA 02035

You acknowledge that you have read this Agreement, understand it and agree to be
bound by its terms and conditions. You further agree that it is the complete and
exclusive statement of the Agreement between you and ICONICS which supersedes
any proposal or prior Agreement, oral or written, and any other communications
between you and ICONICS relating to the subject matter of the Agreement.

ICONICS RETURN POLICY
All sales are final (NO RETURNS) unless one of the following conditions is applicable:
Program is returned in its original packaging material within 7 days after shipment. In
such a case, a full refund is provided, less all incurred shipping and handling costs.
Program is returned within 30 days from the original shipment date. In such a case a
20% restocking fee is applicable. No returns are allowed on OPC ToolWorX or ActiveX
ToolWorX. All returns must have an appropriate RMA number.

EXPORT COMPLIANCE
You agree to comply with the United States of America’s current Export Administration
Regulations (EAR) and agree that you will not distribute or supply this product in
violation of the EAR. You are responsible for securing any export approval or license
as may be needed under the EAR. Additionally, you are responsible for obtaining local
customs clearance as applicable and paying all duties, taxes and other charges.
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1 MoBILEHMI OVERVIEW

1.1 Introduction

In an increasingly web-connected environment operators
from many industries have begun benefiting from mobile
applications aimed at providing optimized operational
experiences for everyday tasks. Expectations of software
companies have centered on providing limitless access to
information over wired, wireless and cellular connections.
Due to this trend and the advance of mobile technologies,
ICONICS has responded by completely renewing the
MobileHMI product that is now available on the major
providers of mobile devices — Microsoft, Apple, Amazon and
Google — ICONICS MobileHMI is a full HMI/SCADA client on
any device.

Spanning desktops, tablets and phones, ICONICS products
have always been centered on visualization of data. With
MobileHMI, tablets and phones now include a fully featured
mobile client designed for operations on the go. With
configuration enhancements meant to simplify development
of screens for mobile users, it is easier to provide a clean
experience on all devices without incurring the extra cost of
development time. Additionally, preconfigured templates and
the ability to target specific devices with displays makes
MobileHMI ready to handle any composition of devices.

MobileHMI addresses the growing need for connectivity
away from operator stations which allows personnel to
access information from anywhere reducing the time it takes
for issues to be recognized and fixed. The availability on all
devices with consistent experiences also serves to unify
efforts to mobilize operational teams without requiring
upfront investment in device standardization.

ICONICS
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Built on Industry Open Standards

Using ICONICS’ Platform Services, MobileHMI is built on
universal connectivity, allowing users to connect to system
data from anywhere in the world. Native implementations of
connectivity protocols allow MobileHMI to provide an
unparalleled view of a wide variety of data types.

Instant KPIs and Alerts

Instantly receiving KPIs and alerts day or night on your
mobile device allows you to be informed 24/7. This enables
managers to monitor performance metrics in real time and
operators to receive updates on-the-go.

Quick Deployment to Any Device

Deployment is instant after downloading the free app,
allowing remote monitoring of your enterprise immediately.
Devices can include Microsoft Surfaces, Windows 8 Phones
and tablets, Apple iPads and iPhones, Amazon Kindle
tablets, and Android phones and tablets.

Dazzling Graphics, Alarms, Trends, Charts and Grids

With mobile optimized alarms and assets (categorized by
importance), quickly view your top priority alarms and act
faster with better information. Accessing the high-powered
.NET graphical controls from any device reduces
engineering time of mobile-ready displays and utilizes small
screen sizes efficiently.

Overlay Real-time Data on Detailed Maps

Along with the real time data collected, implement mapping
(integrated with Google, Bing, and ESRI map data) to show
moving or geographically dispersed assets. Contextualize
data into easy-to-comprehend information by positioning
interactive assets virtually on a map.

1-2 ICONICS
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Easily Design HMI Displays for Multiple Devices

Using GraphWorX64, create single displays that scale
dynamically for any device, form factor or resolution. Vector
graphics scale seamlessly allowing content created for one
device to be resized for another without losing quality.

Standardized on ISA-95 Asset Navigation and
Organization

Creating and navigating assets is easy using the ISA-95
organization. Allowing users to drill down for more data, the
ISA-95 Asset Navigation can provide easy access to real
world assets, as well as integrate commands to control their
application.

Smart Tiles with an Intuitive Interface

ICONICS enables many natural user interface-based
productivity features delivered by the latest smart devices.
Smart Tiles are similar to Microsoft’s Live Tiles, but can be
used within HMI displays on multiple devices.

Remote Monitoring of Critical Infrastructure

Remote monitoring with this application is ideal for industries
such as Water & Wastewater, Wind, Solar and Renewable
Energy, Process Manufacturing, Pharmaceuticals, Biotech,
Oil & Gas and Electric Utilities. Remote Monitoring is also
useful for management scorecards and Data Centers.

Ideal for Operators, Executives and Maintenance

This mobile solution allows operators to stay informed, even
while traveling, by viewing assets with navigation.
Executives can visualize business performance and improve
enterprise-wide communications. With real-time updates and
information delivered through remote monitoring,
maintenance is easier than ever to plan and schedule.

KPIWorX Self-Service Dashboards

KPIWorX allows for the creation, saving and loading of
dashboards, providing a user-friendly interface. Users can
drag and drop data, configure widgets, split screens to add
new widgets and save dashboards into a Favorites location.
KPIWorX is accessible through MobileHMI as well as within
GraphWorX64 (which can handle more complex displays).
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KPIWorX contains several preconfigured widgets, such as
gauges, process points, trends, alarms and grids. Primarily a
mobile feature, all new functionality is also available on the
desktop.

Augmented Reality — Location Services

Location Services are a group of Augmented Reality
MobileHMI features that allow displays to automatically load
and display data based on the users’ location and proximity
to devices and meters. These services include QR codes,
barcodes, NFC, OCR and GPS.
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2 SYSTEM REQUIREMENTS

MobileHMI has the following minimum system requirements
which your systems must meet before you can install
MobileHMI.

Before installing any products please make sure you have
the correct prerequisites installed.

ICONICS Suite

ICONICS advanced visualization, productivity, and
sustainability solutions are built on its flagship products:
GENESIS64™ HMI/SCADA, Hyper Historian™ plant
historian, AnalytiX® solution suite and MobileHMI™ mobile
apps. ICONICS is leading the way in cloud-based solutions
with loTWorX™, which helps customers embrace the
Internet of Things (IoT) and Industry 4.0. This end-to-end
software solution provides remote cloud monitoring and
analytics via low-cost loT gateway devices. Delivering
information anytime, anywhere, ICONICS solutions scale
from the smallest standalone embedded projects to the
largest enterprise applications.

ICONICS System Requirements vary between:
. Minimum Requirements
. Medium-powered Requirements
e High-powered Requirements

ICONICS
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System Requirements - Minimum Requirements

CPU

Dual Core 64-bit processors (e.g., AMD Athlon 64 X2, Intel
Xeon, and AMD Phenom)

Memory
4 GB of RAM is required (6 GB Recommended)

Note: It is recommended that the system page file size be a
minimum of four (4) times the size of installed (physical)
RAM.

Note: It is recommended that the virtual memory allotment
be two times the amount of physical memory (RAM) on the
system.

Hard Disk

At least 4 GB free hard disk space is required (10 GB
Recommended)

Drive
DVD Dirive for Installation

Video Card

Onboard Video Memory (256MB) Display resolution
minimum - 1024x768, 32-bit color

DirectX 9 or 10 Video Card or better

Operating System
e  Windows 10 x64 (Pro or Enterprise Edition)
e  Windows 8.1 x64 (Pro or Enterprise Edition)

e  Windows 7 SP1 x64 (Professional or Enterprise
Edition)

. Windows Server 2019
. Windows Server 2016 x64

2-2
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. Windows Server 2012 R2 x64
. Windows Server 2012 x64

Note: Windows 10 Anniversary Update is required for
MobileHMI UWP app.

Note: Server-class operating system highly recommended
for web hosting and AnalytiX features.

.NET Framework
Microsoft .NET Framework 4.7.2

Web Server/Access
Microsoft Internet Information Services (11S) 7.0 or higher

Edge, Internet Explorer,Firefox, Safari, or Chrome

SQL Server
. Microsoft SQL Server 2019
. Microsoft SQL Server 2017
. Microsoft SQL Server 2016
. Microsoft SQL Server 2014
. Microsoft SQL Server 2012 R2

e  The connection to SQL Server data source may
be either local or remote.

. ICONICS supports SQL databases with
encryption.

ICONICS 2-3
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System Requirements - Medium-powered Requirements

CPU

Quad Core 64-bit processors or better (e.g., AMD Athlon 64
X2, Intel Xeon, and AMD Phenom)

Memory
8 GB of RAM or higher
Note: It is recommended that the system page file size be

a minimum of four (4) times the size of installed (physical)
RAM.

Note: It is recommended that the virtual memory allotment
be two times the amount of physical memory (RAM) on the
system.

Hard Disk

At least 4 GB free hard disk space is required (10 GB
Recommended)

Drive
DVD Dirive for Installation

Video Card

Onboard Video Memory (500MB) Display resolution
minimum - 1024x768, 32-bit color

DirectX 9 or 10 Video Card or better

Operating System
e  Windows 10 x64 (Pro or Enterprise Edition)
e  Windows 8.1 x64 (Pro or Enterprise Edition)
. Windows 8 x64 (Pro or Enterprise Edition)

. Windows 7 SP1 x64 (Professional or Enterprise
Edition)

24
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Windows Server 2019
Windows Server 2016 x64
Windows Server 2012 R2 x64
Windows Server 2012 x64

Note: Windows 10 Anniversary Update is required for
MobileHMI UWPapp.

Note: Server class operating system highly recommended
for web hosting and AnalytiX features.

.NET Framework
Microsoft .NET Framework 4.7.2

Web Server/Access

Microsoft Internet Information Services (11S) 7.0 or higher

Edge, Internet Explorer, Firefox, Safari, or Chrome

SQL Server

Microsoft SQL Server 2017
Microsoft SQL Server 2016
Microsoft SQL Server 2014
Microsoft SQL Server 2012 R2
Microsoft SQL Server 2008 R2 SP1

The connection to SQL Server data source may
be either local or remote.

ICONICS supports SQL databases with
encryption.

ICONICS
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System Requirements - High Powered Requirements

CPU

Quad Core 64-bit processors or better (e.g., AMD Athlon 64
X2, Intel Xeon, and AMD Phenom)

Memory
16 GB of RAM or higher
Note: It is recommended that the system page file size be

a minimum of four (4) times the size of installed (physical)
RAM.

Note: It is recommended that the virtual memory allotment
be two times the amount of physical memory (RAM)

on the system.

Hard Disk

At least 4 GB free hard disk space is required (10 GB
Recommended)

Drive
DVD Dirive for Installation

Video Card

Onboard Video Memory (1GB) Display resolution minimum -
1920x1080, 32-bit color

DirectX 9 or 10 Video Card or better

Operating System

Windows 10 x64 (Pro or Enterprise Edition)

Windows 8.1 x64 (Pro or Enterprise Edition)

Windows 8 x64 (Pro or Enterprise Edition)

Windows 7 SP1 x64 (Professional or Enterprise Edition)
Windows Server 2019

2-6
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Windows Server 2016 x64
Windows Server 2012 R2 x64
Windows Server 2012 x64

Note: Windows 10 Anniversary Update is required for
MobileHMI UWP app.

Note: Server class operating system highly recommended
for web hosting and AnalytiX features.

.NET Framework
Microsoft .NET Framework 4.7.2

Web Server/Access
Microsoft Internet Information Services (IIS) 7.0 or higher

Edge, Internet Explorer, Firefox, Safari, or Chrome

SQL Server

Microsoft SQL Server 2017
Microsoft SQL Server 2016
Microsoft SQL Server 2014
Microsoft SQL Server 2012 R2
Microsoft SQL Server 2008 R2 SP1

Notes:

1. The connection to SQL Server data source may
be either local or remote.

2. ICONICS supports SQL databases with
encryption.

ICONICS
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NOTE: The requirements described above are based on
typical applications. Depending

on your specific application, the minimum requirements may
vary.

Optional Hardware
. Ethernet adapter, WiFi card, or cellular 3G/4G
. USB port (for hardware license)
. Serial COM ports or other adapters (for data I1/O)

Uninstalling

It is recommended by ICONICS to use Add/Remove
Applications from Control Panel to uninstall the applications.
Since applications are registered in the registry,
Add/Remove uninstalls the product and makes the required
registry changes for you.

If you uninstall some common components that are used by
the product, you may be required to register those
components again or simply reinstall the product.

NOTE: Do not delete the files and directories manually;
doing so will leave the registry entries intact and interfere
with future installations. Please use the uninstall feature of
the operating system!

2-8 ICONICS



3 INSTALLING MoBILEHMI

The following steps detail the MobileHMI system installation.

MobileHMI's installation uses a standard InstallShield
installer to provide you with options for installing
components, adding new or existing users, configuring the
database engine that you use and the size of the tables that
are created, and more.

Warning: Prior to installation, verify that the system meets
minimum hardware and software requirements, as described
in the System Requirements section. Installation will abort if
the minimum requirements are not met.

Note: You cannot install any 10.8x product from Remote
Desktop when using a shared drive. In such instances, it is
suggested that you copy the installation's sources to a local
drive or share the drive via Windows networking rather than
via Remote Desktop.

Important Note: Uninstall previous versions of
MobileHMI before installing the latest version of
MobileHMI.

3.1 Starting the Installation Process

Note: Installations of Internet Information Services differ
depending on the operating system, but can be found in the
Server Manager under Roles in Windows Server 2012 and
should be turned on.

To Install MobileHMI:

1. Insert the installation DVD into your optical drive and
the installer will open if auto start is operating correctly;
if not, open the DVD drive window and double-click the
Default.hta file icon. Select “MobileHMI Installation”.

2.  When the Prerequisites Installer Dialog appears,
choose ‘Install’. This installs everything needed for
running MobileHMI. If you don’t have installed SQL
Server 2014 locally, a prompt appears to install it. (You
can choose No if you use an older version of SQL
Server, or you plan to use a remote SQL Server)

ICONICS
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ICONICS MobileHMI - InstallShield Wizard

= [CONICS MobileHMI requires the following items to be installed on your computer, Click
’I Install to begin installing these requirements.

Status  Reguirement

Pending Preparing System

Pending 54U Connector for SAP OLE DB Provider (x64)
Pending OPC UA Local Discovery Server 1,02

Pending Sentinel Protection Installer 7.6.7

Install | | Cancel ‘

3. In the Welcome Dialog, click the Next button to view
the License Agreement step.

ICONICS MobileHMI X

MobileHMI"

v 1095

, 2=
> lﬂm&' ICONICS, Inc.
=

©1986-2017
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Installing MobileHMI

Read the License Agreement. If you agree, click the “I
accept the terms of the license agreement” radio
button. Then click Next to continue.

ICONICS Suite - InstallShield Wizard X

> I'L'M;-;\E'S
=

ICOMICS LICENSE AGREEMENT -
YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND COMDITIONS!

Opening and using the enclosed software for any puipose indicates your acceptance of the terms:
and conditions of this licanse agiesment. f you da niat aqree with them you should return al
saftware, dosumentation and capy protection keys vithin seven days of shipment unopened and
wout morey wil be refunded

ICOMICS providss this program and lisenses its use in the United States. Pustta Rica. or
intemalionally. ou assume the respansibiity for the seleclion of the program (o achisve your
intended resuts, and for the installafion, use and results obtained from this program.

LICENSE
‘You are oranted a personal icense to use this program under the terms stated in this Agreement
You may: 1) Install and use the proaram on a sinle machine; and 2) make a single archival v

(@1 accept the teims of the license agreement Print

(O do nat aceept the terms of the license agreement

< Back s

Read the license, and select “I accept the terms in the
license agreement”. Click Next.

You can proceed with the installation only after
accepting the terms.

In the Setup Type Dialog that appears, select the type
of setup you wish to perform.
Select from either Custom or Typical.

e  Typical installation installs all of the
components of MobileHMI (This requires
more disk space).

. Custom installation allows you to pick the
components to be installed.

Since the Setup procedure varies slightly depending on
the installation type you choose, the installation of each
is described fully in the two sections that follow. Refer
to “Typical Installation” below, or “Custom Installation”
later in this section.

ICONICS
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ICONICS Suite - InstallShield Wizard X
|
» ICONICS
Click the type of setup you prefer. then click New.
® Typical
Program wil be installed wih the most cammon options, Recommended for mast
users.
(O Custom

You may select the opticns you want ta install. Fiecammended for advanced users

<Back Cancsl

7. Inthe Logon Information Dialog, you can choose to
use either a local machine account or a domain security
account, as well as create a new user or use an
existing user account.

3.2 Typical Installation

Typical installation is meant to install all of the MobileHMI
applications and tools. This creates all of the supporting
databases.

You need to provide the correct database connection and
logon information. Once those steps are completed, the
installation does not require as much of your attention.

If you are installing MobileHMI on a system that has a
previous version of ICONICS products already installed,
uninstall the older version before installing MobileHMI. If you
have uninstalled a previous version, Setup leaves the
database files intact on your system for you to use at a
future date. Typical installation asks you if you want to
overwrite or leave the supporting database files.

34
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To Perform a Typical installation:

1. Click the Typical radio button in the Setup Type dialog
box pictured above. Setup evaluates your system for
compliance with the requirements, and then posts a
confirmation dialog box.

2.  Click the Install button to begin the MobileHMI User
Setup Wizard. Then click the Next button to start the
wizard.

3. The Typical installation now asks you if you'd like to
install the GenDemo (which includes sample displays,
examples and tutorials) to get you up and
running. Select this option if desired and click Next.
At this time additional components are installed
automatically.

[ wWorkbench Lient
[JLapout and Multimedia Manager
[ ebHMI Client

[ Quality Analpti

301 GB of space required on the C diive
Select Al | | Deselect Options 108.02 GB of space avalable on the C drive

< Back Canicel

4. The Logon Information screen appears.
Enter the requested user name/password info. Then
click Next.

Note: From the Logon Information Dialog, you can
choose to use either a local machine account or a
domain security account, as well as create a new user
or use an existing user account.

ICONICS 3-5
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ICONICS Suite - InstallShield Wizard X
. 2=
» ICONICS

Specify the user acoount to be used by this application. Lser acoounts must be in the fomat
DOMAINAIsemame

User name:

(20160210 acimin || Erowse.

Pagsword:

Select the buttan below to specify information about a new user that will be
created during the installation

Mew User Information...

< Back Cancel

5.  Clicking Next brings up the Database Server Dialog. Here
you can select a local or remote database together with
database settings and the authentication that server

database is secured under.
ICOMNICS Suite - InstallShield Wizard X

> icml"‘?cs
=

Database server that you are instaling to:

| | Biowss

Connect Using: Databases Creation

(@) Windows authentication
Use Active Databases [MA]

(O 50L Server authentication [ Silent Configuration

Login 1D s Include all Samples

Password [ Ovewite all Databases

[ Use Unified Database
Enable Project Reporting [Automatically) Database Prefiz

< Back Cancel
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Use Active Databases — Databases from previous
installations of MobileHMI are attached to this
installation.

Silent Configuration — Databases are installed with
selected settings, and there won’t be additional dialog
with advanced database setting.

Include all Samples — Installs sample data that you
can experiment with.

Overwrite all Databases — Overwrite older Databases.
Use Unified Database — Installs all configuration in
one unified database.

Enable Project Reporting — Enables and sets up
Project Reporting on SQL server if possible (Project
Reporting is supported on SQL 2008 R2 and higher).

6. The System Setup Dialog appears. You can either
leave the Include all samples checkbox enabled, (in
order to install sample data that you can experiment
with) or disable this checkbox to install blank tables.
Advanced configuration allows settings for additional
sizing options on the database and log files. You can
enable Unified database (one database that contains all
the configurations) and enable Overwrite all (overwrite
all existing databases), or you can use Upgrade to
automatically upgrade all database configurations.

K System Setup — ] X
Configuration Settings
[ Install all configurations in one unified database IcoUnifiedCenfig .

Database Prefix:

Include samples in all configurations
[] Gverwrite all configuraticns
[[] Upgrade autematically all configurations

Available Configurations

Database Name | Configuration Type Samples | Overwrite| Upgrade | Options |
» AlertConfig AleriWor Inital Size: 10, M..[_. |
AssetWorX Assets (] Inital Size: 10, MII'
AvaLogger AlarmWorX64 Logger ] Inital Size: 10, M. .. |
AwsServer AlsrmWorX64 Server [ Inital Size: 10, M..[ .. |
BACnet BACnet Inital Size: 10, M..| .. |
BiConfig B Server ] Inital Size: 10, M.. . | -
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7.  Click the Install button to continue the installation.

8.  After completing the installation, the Wizard Completed
dialog box appears.
Click the Finish button.

ICONICS Suite - InstallShield Wizard

InstallS hield Wizard Complete

Tha n k yO u The InstallShield Wizard has successfully installed ICONICS Suite.
for choosing

Before pou can use the progran, pou must restart your computer.

ICONICS
software

(@ Yes. | want ta restart my computer now

(O Mo, | will restart my computer later,

=
»:@E‘s

< Back Cancel

Note: If the installation lags, check to see that there aren't
any alert boxes that require your dismissal prior to
completing the installation.

3.3 Custom Installation

Custom installation varies slightly from the Typical
installation, in that it allows you to select the components
you wish to install manually.

1.  Select the Custom Installation Setup Type.
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ICONICS Suite - InstaliShield Wizard *
. 2=
» ICONICS
Click the typs of sshup pou pirsfs, e click Nast

O Typical

Program will be installed with the most common options. Recommended for most
users.

(®) Custom

Vou may select the optians you want to install Flecommended for advanced users

<Back Cangel

2. You are prompted to select the Destination
Location.
Specify the destination by selecting Browse, or
select Next if the default location is correct.

3.  Click the checkboxes to install your selected

components.
ICONICS Suite - InstallShield Wizard b'e
|
» ICONICS
. A Suite Options
&1 [ A server
Platform Services I GENESISE4
| Application Servers MobileHMI
b pplications
anveteiwon [THyper Historian
[ Alaminfois Multimedia

Client Camron

Graphwoix [ Energy Analptix
[Aviewers for Graphiw/ors 1 Faciity Ansltid
[A Symbol Library
[ATemplates [ Gty Ay
~[]Phone Templates
Poralwoix-5F
-[AARepartfai Express
AN melobmmbs Plizimt

301 G of space required on the C diive:
Select All | | Deselect Options 108.05 GB of space svailable o the C drive

<Back Cancel
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4.  Click the Install button to continue the installation.

5. In the Database Server Dialog, you can select
local or remote database together with database
settings and authentication. The server is secured
under this database.

ICONICS Suite - InstallShield Wizard x

> I'L'M/TE’S
=

Specify the user account to be used by this application. User accounts must be in the format
DOMAINA semame.

User name:

(72016041t acin || Browse

Password

Select the buttan below to specify information about a new user that will be
created during the installation,

Mew Lser Information.

<Back Cancel

Use Active Databases — Databases from previous
installations of MobileHMI are attached to this
installation.

Silent Configuration — Databases are installed with
selected settings. There will not be additional dialogs
with advanced database settings.

Include all Samples — Installs sample data that you
can experiment with.

Overwrite all Databases — Overwrites older
Databases.

Use Unified Database — Installs all configuration in
one unified database.

Enable Project Reporting — Enables and sets up
Project Reporting on SQL server if possible (Project
Reporting is supported on SQL 2008 R2 and higher).
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6. The System Setup Dialog appears. You can
either leave the Include all samples checkbox
enabled, (in order to install sample data that you
can experiment with) or disable this checkbox to
install blank tables. Advanced configuration allows
settings for additional sizing options on the
database and log files. You can enable Unified
database (one database that contains all the
configurations) and enable Overwrite all (overwrite
all existing databases), or you can use Upgrade
automatically, to upgrade all database
configurations (existing databases will be
automatically upgraded to the newest version).

R System Setup - o x
Configuration Settings
[ Install all configurations in one unified database lcoUnifiedConfig )

Database Prefix:

Include samples in all configurations
[] Overwrite all configurations
[] Upgrade automatically all configurations

Available Configurations

Database Name | Configuration Type

Samples | Overwrite

Upgrade | Options ‘

> AlertConfig
AssetorX

AlertWorX
Assets
AwxLogger AlarmWorX64 Logger u
AwxServer
BAChet
BiConfig

AlarmWorXe4 Server u
BACnet
Bl Server [}

Inital Size: 10, M., |
Inital Size: 10, M. .|
Inital Size: 10, M...[ |
Inital Size: 10, M..[ .|
Inital Size: 10, M... ., |

Inital Size: 10, M... .. | -

=

Click the Install button to continue the installation.

After completing the installation, the Wizard
Completed dialog box appears.
Click the Finish button.

ICONICS
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3.4 Uninstalling MobileHMI

The MobileHMI software can be uninstalled (removed) from
the system. It is recommended that you back up all of your
project-related files before uninstalling. If your operating
system requires a login, you must log in with administrator
capability to uninstall. Uninstalling MobileHMI Software (or
its components) does not uninstall the Licensing software.
Your valid license will remain activated on your PC.

It is recommended by ICONICS to use Add/Remove
Applications from Control Panel to uninstall the applications.
Since applications are registered in the Registry,
Add/Remove uninstalls the product and makes the required
Registry changes for you. If you uninstall some common
components that are used by the product, you may be
required to register those components again or simply
reinstall the product.

Uninstalling MobileHMI:

1. From the Windows Start menu, select Settings >
Control Panel.

2. Double-click Programs and Features.
From the list of programs that you can remove,
select ICONICS MobileHMI.

3. Click Change/Remove or Uninstall to remove
MobileHMI and all of its components.

4. Select Remove, and then click the Next button.
When the files are removed, the uninstall program
will indicate that the process is complete.

Note: Do not delete the files and directories manually; doing
so leaves the Registry entries intact and interferes with
future installations. Please use the uninstall feature of the
operating system.

3-12
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4 ICONICS SOFTWARE LICENSING

4.1 Software and Hardware Keys

AnalytiX licensing is handled by a software key license
registration system that does not require a hardware
protection key. However, ICONICS does offer an optional
hardware key which you can purchase.

Software Licensing

The software key is a licensing key that resides on the hard
drive of a computer. Each software key is used on a single,
specific computer and is used only once. It is activated using
a Site Key (license file) that is tied to the computer that is
being licensed.

An activated license is required to use the software in full
production mode. This license designates which products
may be used, as well as the 1/0O point-count limit that controls
the number of active data points (tags) that can be used by a
system.

For important details about registering and activating
software licenses for your AnalytiX installations, refer to the
ICONICS .NET Licensing Readme.htm file, which is
available on your AnalytiX installation DVD (and as a link
from the disc’s Info Center).

Hardware Key

The optional hardware key is a USB thumb drive (or flash
drive) that you can move from system to system. AnalytiX
recognizes the hardware key on the system you have the
key attached to. A hardware key is easier and is a more
reliable way of moving a license from one machine to
another than a software key.

Upon insertion of the USB key into an available USB port,
the necessary drivers are automatically loaded.

A green status light will illuminate upon successful
connection.

ICONICS
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Should the USB key be missing or unplugged during
operation of AnalytiX software, plug the USB key back in
either within an hour of removal or upon system reboot;
otherwise the hardware-based license will not be
immediately recognized.

Should you require a replacement key, visit
http://www.iconics.com/supportworx. New users must create
an account through the ICONICS Web Licensing Utility in
order to request replacement keys.

4.2 Licensing Utility

The Software Licensing Utility provides full authorization for
use to any purchased AnalytiX product and its available
options.

421 Running the Licensing Utility

To launch the License Utility from the Windows Start menu,
select Programs > ICONICS .NET Licensing > Licensing
Utility.

1 Software License Activation |L|£-

File License Help

ri@'&s Software Licensing

Information
Site Code: XXX )OO0 XOOGCKKK XX KXXXX

Ste Key: [No Current Site Key

Phumbers: [ o Cumert PNumbers

[ Copy PNumbers to Cipboard |

License File

Browse.

Activate License

Activate Tial License |

Kill Current License
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422 License File

Once you have opened the Software Licensing Utility, you
can browse for the Site Key (License File) itself. Either click
on the Browse... button in the License File section of the
window OR click on File in the top menu, then Select
License File....

| Software License Activation | = |2 -

Hel

License
Select License File...
Exit

Information

Site Code: [ODOE 31F3 9DEF 4052 CC X1085 |

Site Key: [ No Curent Site Key |

PNumbers: | No Currert PMumbers

| Copy PMumbers to Clipboard |

License File

Activate License

Activate Trial License |

Kill Current License

This brings up the Windows Explorer so that you may
browse for the License File itself. Once you have located the
file, double-click it or click Open to proceed.
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423 Activating the 30-day Trial/Emergency License

Within the Licensing Utility (Software License Activation for
.NET) dialog box, you can click on the Activate Trial
License box to initiate a 30-day trial/lemergency license.

NOTE: This license can be activated only once per
machine.

1+ Software License Activation IL‘E-

File License Help

bi@s Software Licensing

Information
Site Code: XG0 OO MO 0K

Site Key: | No Currert Ste Key

PNumbers: | No Cument PNumbers

| Copy PNumbers to Clipboard ‘

License File

|

Activate License

< Activate Trial License D

Kill Cumrertt License

You will then see a warning about proceeding with activating

the 30-day trial/lemergency license. Click Yes, should you
wish to proceed.

Warning |L|

The 30-day trial/emergency license can only be activated once per machine
Doing so will change your site cede and will invalidate any software license
currently active on the machine.

Are you sure you want to continue?

ICONICS
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You will then see an additional warning confirming that you
understand that enabling the trial license will invalidate any
other software license that is currently active on the
machine. Click Yes should you wish to proceed.

Warning \L‘

Enabling this trial license will invalidate any software license currently active on
the machine. Are you sure you want te continue?

Once the 30-day trial/emergency license has been enabled,
you will see the following messages:

Success -

License Activated Successfully

Success -

Emergency/Trial License Activated

The PC will then be authorized to run for a one-time only,
30-day backup period. The PC can be fully authorized at any
time during or at the conclusion of this temporary backup
period. Clicking No in the initial windows returns you to the
Licensing Utility (Software License Activation for .NET)
dialog box and preserves the existing license.
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4.2.4

Note: Temporary backup license authorization is intended
for urgent backup situations only. Clicking OK invalidates the
existing license and activates a temporary backup
authorization, permanently overwriting any existing license.
Thus, please use caution when activating a temporary
backup license authorization.

Killing a Software Key License

Killing a software key license deletes it and removes the
current software license from the machine.

To Kill or Delete the Existing Software License:

1. Select Kill Current License within the Licensing Utility
(Software License Activation for .NET) dialog box.
Using this option, you can remove the current software
license from the current machine.

+  Software License Activation ILIE-

File License Help

bf@}s Software Licensing

Information
Site Cadz: 3000( X000¢ Xo00( X000 XX XXX
Site Key:  [No Curent Site Key

PNumbers: | No Cumert PNumbers

‘ Copy PNumbers to Clipboard ‘

License Fie
[ |

Activate License

Activate Trial License
E Kill Cumentt License b
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A warning message appears on the screen as shown in the

figure below.
Warning £

Are you sure you want to kill the current license?
This action is permanent

IMPORTANT: If you kill your license, you need to get a new
license from ICONICS to restart your AnalytiX product.

2. Click Yes to continue, or click No to exit. Clicking Yes
displays one of the following warning messages.

If you are killing a trial or emergency license, once you
click Yes you are done.

Note: A trial or emergency license cannot be credited
back to the web-based License Generator using the Kill
Code.

If you are killing a permanent, registered license, after
you click Yes, the following warning message appears.
Notice that the message lists the old Site Key, and a Kill
Code. It also lists a .TXT file that has been written to
the PC's desktop; the file name begins with "KillCode".
This file contains the old Site Key and Kill Code that are
listed in the message.
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License Killed

License killed successfully.
License information displayed below and written to:
C:\Users\admin\Desktop|

Please keep a copy of the information for your records.

Old Site Key:
59C3 6ED9 BOBS 7E10 AABD D360 2E Copy

Kill Code:
5227 CCD1 8601 7D65 95C3 044A 3D5A FB Copy

oK

3. Click Yes to copy the Kill Code to the Windows
Clipboard so that you can paste it elsewhere,
such as in an email to ICONICS Support or on
the ICONICS Web Licensing Utility. If you don't
need to copy the Kill Code at this time, click No.

4. Look on the desktop for the KillCode*.TXT file.
Keep this file, and copy it to a safe location!
You will have to use the information it contains to
confirm that you have killed your license (via
either the ICONICS Order Entry Department or
the ICONICS Web Licensing Utility).

5. Proceed with the online steps described in
4.4.3.1 “Killing a License via the ICONICS Web
Licensing Utility”

Note: To reinstate a permanent license that you killed,
you will need to provide the KillCode*.TXT file to
ICONICS.

4-8
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Note: If you uninstall the Software License Utility, the
KillCode*.TXT file will be deleted. For this reason,
make sure you copy the KillCode*.TXT file to a safe
location or be sure to note or print its content before
uninstalling the Software License Utility on the PC. [*
= Site Key that was killed.]

4.3 License Viewer

When you purchase licenses, the licenses are measured in a
point count that determines the number of OPC tags that you
can use in your application. One point count is used for most
AnalytiX applications. There are two different modes for
using tags in point counts:

On-demand mode. A system for dynamically using licensed
points, and then reusing the points as needed. The count
at any instance includes only active points in use.

Configure mode. A system in which all points are
statically configured in a static central location, inside
the Unified Data Manager. All configured points are
counted against the point count.

The two mode types are not interchangeable and require
you to buy a new license to upgrade your existing license
status.

At any time, you can use the License Viewer to review the
license status of ICONICS products installed on that
computer. You can access the License Viewer by:

From the Windows desktop: click Start > All Programs
> ICONICS Licensing > ICONICS .NET Licensing >
MonitorWorX Viewer.

From the Workbench: from the Tools ribbon click the
Licensing button. Or from the File menu, select Tools,
and then Licensing. The License Viewer displays as
shown in the following image.

ICONICS
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Ll MonitoriorX Viewer - oM

@

The tab that displays initially is the Overview tab, where you
can see general information about the license for the server
that the node points to. You can view license information for
GENESIS64, AnalytiX, Data Connectors, BizViz products
(under the AnalytiX tab), and AlarmWorX Multimedia
product features by using the tabs for those products. To
locate the nodes where individual product features are
consuming the server's license counts, use the Diagnostics
tab.

4.4 Web Licensing

You can use the ICONICS Web Licensing Utility to generate
a new license, kill a license and transfer a license. One
function of the ICONICS Web Licensing Utility is to use it to
upgrade your license.

Supported operating systems for using the ICONICS Web
Licensing Utility to upgrade your license include Windows 8
x64 (Professional or Enterprise Edition), Windows 7 x64
(Professional, Ultimate, or Enterprise Edition), Windows
Server 2008 R2 x64, Windows Vista x64 SP2 (Business,
Ultimate, or Enterprise Edition), Windows Server 2008 x64
or Windows Server 2003 x64. Using the utility will require
Internet access and a web browser (e.g. Internet Explorer
6.0 and up).

4-10
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441

Acquiring a New Software License

Users of ICONICS software can use the ICONICS Web
Licensing Utility to acquire a new software key license.

4411

1.

Issuing a New Software License

On the machine where you want the AnalytiX

license to reside, open the License Utility by going
to Start -> Programs -> ICONICS Licensing ->
ICONICS .NET Licensing -> Licensing Utility.
This should open the Software License Activation
for .NET window.

You will see a dialog come up with a Site Code

and “No Current Site Key” within the Site Key text
box. Leave this window open.

)

Software License Activation | = | = [0 |

File License Help

»ic{y}s Software Licensing

Irformation
Site Code

2000 00K XK O XX XXXXX

Ste Key: [No Curent Ste Key

PNumbers

No Cumrent PNumbers

[ Copy PHumbers to Clipboard

License File

Activate License

Activate Tral Licenss |

Kill Cumrert License
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3.  Go to http://www.iconics.com/supportworx and
launch the Web Licensing Ultility Site by clicking on
the “License Product” link on the right side of the
page.

ISHUSUS=
cance i @
ol

[ = [0 = e T —

=

Or, from ICONICS website
(http://www.iconics.com), select “License Your
Product” from the bottom-right Customer
Connection area.

4. The main page of the Web Licensing Utility will
load. Click on the “Software” button to access the
Software License Options.

ICONICS Web Licensing Utility

F ‘Software ]; Hardware q
| 2 :
— P I
‘-‘Qﬁ a\\{“
S B GENESIS64

Hyper igy .
wwwﬂ
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5.

You will be required to log in to access the
Software License Options. Enter your email
address and password and click on the “LOGIN”
button. If you do not yet have an account, you can
create one by clicking on the “Create New
Account” link near the bottom of the page.

Once you have logged into the website, click on
the “New License” link in the top navigation bar.

Enter your Product Registration Numbers and
Customer Keys for the products to license, then
click “Next”.

NOTE: Your Product Registration Number and
Customer Key are usually inside the DVD package
that ICONICS sent to you.

ew License

ICONICS
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8. In the next screen, you will be requested to identify
the end user for whom the license is being issued.
You can look up a list of users that have been
previously entered by clicking on the “Existing End
Users” link or can enter a new one by clicking on
the “Create New” link.

End Usor informaticn
Please identity an End Liser by chohing cne of e opions below

Exignng End Ugors Lreaty Hew

9. Clicking the Existing End Users link will open a
new window with a list of previously entered end
users (either entered by you or tied to the product
registration numbers entered in the previous
screen). Select an end user from the list and click
“Select” or double-click the selected end user.

If you, yourself, are the end user and you are not
listed in the grid, you can click on the “l am the
End User” link to enter your data as the new end
user. After identifying the end user, click on “Next”.

End User Look Lip -~ Webpage Dalog ===
END USER LOOK UP
| Select an end wser from the kst below
gy Country Sare
ICOMICE, inc. s Y
ICOMICS, Ine. uss Y
ICOMICS, D uss Y §
JeTy.ne s s -
Creake Hew Lam the Eod User
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10. In the next screen, you will see a list of the
products that are available for you to license.
Check all the products that you would like to
license. Copy the Site Code from the license utility
of the destination machine and paste it into the
Site Code box of the current web page, then click
on “Next”.

New License
Belgw are the DIodverls} that yiu have paurchased and that have nat vet been Fssigrad 3 Ste key

o regitar product(s) 1o a soenfic system, da the follawing

Entor Slte Coda of the PC : S35E 2ACH BAES C104 0123 440 FOES FE

11. Review the license information before proceeding.
Click on “Generate Key” to issue the new Site Key.

Home » Software Lisense » New License
New License
You requested to have the products below be registered to the following Site Code

54B3 AE27 40AD ADE7 D5

[ —— | o 1

[ ceevosesTies 105 e PGB 111 11563 CessesameEs |

Total Bizviz/GEN32 Paint Counts :0

Total GENG4 Paint: Count: 100000

‘Total Hyper Historian Point Count: 100000
License Days

ICONICS
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12. The next page will show you a summary of what

will be your license, as well as your Site Key and

License File.

Home » Software Livenze » New License

The following License File has been assigned to your system for use in license activation.
Use the License File inside the ICONICS Software Licensing Utility.
Please keep the Site Key for future reference purposes.

site Gode: 54B3 AE27 40AD ADE7 D5
Site Key: 1B44 954F E61A 79ED 5FFA 6610 7C

Download the following LICENSE FILE to authorize your license
Click here to download

Registered Products

[~

]

order #

|

lProduct Description|

|GENGI-VIDS TEST LAB. VI0SLICENSE  12Fehvusryao10 25546H0 PNBSST113111111643 ONOEB80SAB3ABSGF A5 CUo2oss |

We recommend that you print this screen far your recards. Use the print friendly button an the left

An email has been sent to your email account with the above information,

Thank you for choosing ICONICS

13.

14.

15.

16.

17.

Download the license file (*.glic) by clicking on the
link. You will need this file to license the machine.
NOTE: If you misplace the file after receiving it,
you can use the View License link with your
Product Registration Number to download it again.
In the Software License Activation Utility, click on
the “Browse” button and look for the license file
that you downloaded from ICONICS website.
Once you have selected the file and the License
File textbox shows the file path, click on the
“Activate License” button.

You should then receive a popup message
indicating the status of the license activation. You
can click on “OK” to close the dialog.

The Software License Activation Utility should now
show the current license information, similar to the
following image.

4-16
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. Software License Activation | =[5 -

File License Help

> i@}s Software Licensing

Information
Site Code: KXXX KK OO0 KK XK

Sie Key: [ No Cument Sie Key

PNumbers: | No Cument PNumbers

‘ Copy PMumbers to Clipboard |

License File

Browse...

Activate License

Activate Trial License |

Kill Cumrent License

18. Notice that the Site Code may change, as
expected, but the Site Key should be the same
one you saw on the website.
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4.4.2 Adding to an Existing Software License

1.  Go to http://www.iconics.com/supportworx and
launch the Web Licensing Utility Site by clicking on
the “License Product” link on the right side of the
page.

2. Once you have logged into the website and
accessed the Software License main page, click on
the “Add to License” link in the top navigation bar.

3. Enter your Existing Site Key, Product Registration
Numbers and Customer Keys, then click “Next”.

Add To License

4. In the next screen, you will see a summary of the
current license and a list of products that are
available for you to add to the existing license.
Check all the products that you would like to
license. Copy the Site Code from the License
Utility of the destination machine and paste it into
the Site Code text box of the current web page,
then click “Next”.

4-18 ICONICS
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5. Review the license information before proceeding.
Select “Generate Key” as shown in the following
image.

Product ey

Products) o Add

SBA7 ASAT FSF2 D208 0439 AG40 CADD 6F

| -

6. The next screen will display the new Site Key and
the link to your license file. Follow steps 13 to 18
from 4.4.1.1 “Issuing a New Software License” to
complete the licensing process.

4.4.3 Upgrading a Software License Key

There are four basic steps when it comes to upgrading a
license via the Web Licensing Utility:

o Step 1: Kill the older version license and credit it on
our website

e Step 2: Upgrade the license on our website

¢ Step 3: Uninstall the older version of software and
install the newer version

e Step 4: License the newer version

The order in which you do Step 2 and Step 3 does not
matter.
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4.4.3.1

Killing a License via the ICONICS Web Licensing Utility

See Section 4.2.4 “Killing a Software Key License” for the
initial steps on how to kill a license within the Licensing Utility
(Software License Activation for .NET) provided on the
AnalytiX DVD. Be sure to take note of the Site Key and Kill
Confirmation Code. This information is necessary to put the
license back on the ICONICS website. NOTE: This
information is also in the KillCode*.TXT file.

[* = Site Key that was killed.]

Once you have the Kill Code, follow these additional steps:

1.  Go to http://www.iconics.com/supportworx and
launch the Web Licensing Ultility Site by clicking on
the “License Product” link on the right side of the
page.

Homa » Sunport > SupBOMHorK

Supportifori

E=E [ Microsoft Partner
= = e
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2. The main page of the Web Licensing Utility will
load. Click on the “Software” button to access the
Software License Options.

ICONICS

ICONICS Web Licensing Utility

Phsace select your Bcence ke tvps bioksw

[ sotwore. o | naraware. o
20

. ‘S\ W{\‘(
Rl

GENESIS64
Hyper Hist/

0

leHM|

3. You will be required to log in to access the
Software License Options. Enter your email
address and password and click on the “LOGIN”
button. If you do not yet have an account, you can
create one by clicking on the “Create New
Account” link near the bottom of the page.

=
]

NICS Web Licensing Utility

o Linaing Uiyt
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4. Click on the “Kill License” link in the top navigation
bar.

5. Copy the Site Key from the KillCode*.TXT file into
the Site Key field on the web page, then copy the
Kill Confirmation Code into the Kill Code field on
the web page. Next, click on the “Remove Key”
button on the web page.

Kill License
Please enter the Site Key to be credited and the assaciated Kill Confirmation Code.

Please enter Site Key and Kill Code exactly as shown in KILLTKT file, indluding spaces.

Site Key: [/BH1 S54F EBTATSED 5FFA G610 7C
Kill Code: [FO57 CEFE FAFE 0555 6053 7A08 4E05 EA

To remove 3 license for GENESIS32, do the following:

1 Gl on start, programs, ICONICS Softwaro License, and select icanss Uty

2. Select the Kill License command fram the Actions men

5. Enter youur name, dsta and the password eol” (ower case) into the dislog bor; then clck the OK butron
The License Uity generates a dialog box containing your Site Key and the associated Kill Code and stores this
information to the KILLTXT file in %SystemDrive%s\Program Files\[CONICS\SoftLic

4. Enter your Site Key and Kill Cocde into the text boxes above; then dick the Remove Key button.

Ta remave a license for GENESIS64, do the following:

1. Click on start, Programs, [CONICS GENESIS64, Licensing Utilty

2. Click the Kill License butfon on the main panel and click ‘0K

3. The License Ukiity generates a dialog box containing your Site Key and the associated Kil Code and stores this
information to the KilCode. tt file on your current desktop.

4. Enter your Site Key and Kill Code into the text boxes above; then dick the Remove Key button.

e |

6. You will get a message confirming that the Site
Key has been successfully deleted as shown in
the image below. The products associated with the
deleted Site Key will now be available to be re-
licensed.

Home » Software Lisense » KilLicense

Kill License

Site Key suceessfully deleted

site Key: 1B44 954F E61A 79ED SFFA 6610 7

Kill Code: 6D57 GEFB FBFE 05B6 BD53 7A08 4ED5 EA
The following products are again available to you for registration:

Available Products

T Promsikey[produt Dossrpton]_oraortste_Jorder#]__pregie | chegto[Customeriia]
|cemeevosTesTLABL vio sucense sesiaro cusozze_|
e

an the laft:

o -

Thank you for choosing ICONICS,
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4.4.3.2 Upgrading the License on ICONICS Website

See Section 4.2.4 “Killing a Software Key License” for the
initial steps on how to kill a license within the Licensing
Utility (Software License Activation for .NET) provided on
the AnalytiX DVD. Be sure to take note of the Site Key
and Kill Confirmation Code. This information is necessary
to put the license back on the ICONICS website. NOTE:
This information is also in the KillCode*.TXT file.

[* = Site Key that was killed.]

1.  After you have copied your Site Key and Kill
Confirmation Code in the previous step (either
physically or electronically), you can now visit
http://www.iconics.com/supportworx.

SupportWorl

PO mmE—

=

2. Next, click on the “License Product” link. This
opens a new Web page, as shown below.

ICONICS Web Licensing Utility

[ Sr— = ——|

—— P S

k‘éﬂma\‘i““{
©5 B GENESISE4

dikd
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3. Click on the “Software” button to proceed. You will
then be required to enter your email address and
password for the site, as shown below. If you do
not already have a login for this page, click on the
“Create New Account” link near the bottom of the
page.

B KM Web Laeming Wi e B s

ICONICS Web Licensing Utility

Wekcone 10 the nesw ICONICS Wab Licensig Utilty!

4.  Once you have logged in, click on the “Kill
License” link in the top navigation bar.

5. Next, fill in your Site Key and Kill Code information
that you copied while killing your previous license
(see 4.2.4 “Killing a Software Key License”).

Kill License
Please enter the Site Key to be credited and the associated Kill Confirmation Code.

Please enter Site Key and Kill Code exactly as shown in KILLTXT file, indluding spaces.

Site Key: [250C 3CDD 0524 B262 2053 456r DA BECE BTe9 0B |
il Code:[CBTE BS2F 6984 0837 F679 6767 59A3 DDEF 010 2480 26EF 99 |

To remove a license for GENESIS32, do the following:

1. Click on Start, Programs, ICONICS Software License, and select License Uiy,

2. Select the KillLicense command from the Actions menu.

3. Enter your name, date and the password “itisok” (lower case) into the dialog box; then diick the OK button.
The License Uty generates a dialog box containing your Site Key and the associated Kil Code and stores this
information to the KILL.TXT file in %SystemDrive?%\Program Files\ICONICS\SoftLic.

4. Enter your Site Key and Kill Code into the text boxes above; then diick the Remove Key button.

To remove a license for GENESIS64, do the following:

1. Click on Start, Programs, ICONICS GENESISG4, Licensing Utiity.
2. Click the KillLicense button on the main panel and dlick 'OK.

. The License Utiity generates 3 dialog box containing your Site Key and the associated Kil Code and stores this
information to the KillCode.bt file on your current de:

skto
4. Enter your Site Key and Kill Code into the text boxes above; then diick the Remove Key button.

™Remove Rey |
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6. Once you kill the license on ICONICS’ website,
you will receive an email containing the following

information:
. Site Key
e Kill Code

. Product for which you have killed the license

The web page itself should now look similar to the
figure below.

Home > Software Lisense > Kil License

Kill License

Site Key successfully deleted
Site Key: 250C 3CDD 0524 B282 2DB3 456F D438 85C5 B799 0B
Kill Code: CB1E B52F 8984 0B87 F679 6767 89A3 DDEF 01C0 24B0 28EF 99

If products in this license are eligible, they may be upgraded to the latest version here.
The following products are again available to you for registration

Available Products

oo e e——— e e e W

Thank you for choosing ICONICS.

7. Atthis point, you have completed killing the
license. Notice that in the final “Kill License” page,
as shown above, it states that if the license is
eligible, it can be upgraded to the latest version
and it provides a link for availability.
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4433 Checking License Upgrade Availability

The easiest way to check if your license is available for an
upgrade is by clicking the link on the page immediately after
you kill the license. Clicking the link brings you to the
Upgrade License page. You can also get to this page by
clicking on the “Upgrade License” link in the tree control

(third item).

Follow these steps to upgrade your license.

1. On the Upgrade License page, fill in your Product

Registration Number and Customer Key. This is
the same information you received in the web
page and in your email after you have killed the
license on our website.

2. Click on “Next” when you have filled in the

necessary information.

3. If the license is available for an upgrade, you will

see the available license on the page.

Below are the product(s) that you have purchased that are available for upgrade.

To upgrade product(s), do the following

Upgrade License

Enable the check box(es) next to the product name(s) that you would ke to upgrade.
3 Chathe Next button to santm

Available Licenses

= T T T e

L= GeN2ve-5000 VB GENS2 RUNTIE 5000 PT- 1 USER | PI2111111111111111 | GNDT23456769123456 Avadable |

P e

4. Notice that the Product Description here shows a

different product with an earlier version license
(Version 8). Yours should reflect the license you
have for your product. Check the available product
that you would like to upgrade and click on “Next”.

5. The next page is a confirmation page. Check that

the information shown is correct and click on the
“Upgrade” button to proceed.

4-26
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444

445

6. On the new page that loads next, you can see a
list of upgraded products. Notice that the Product
Description shows a license for a later version
product (Version 9.2) instead of the earlier one
(Version 8).

Home > General Information » Upgrade License

The following products have been successfully upgraded:

Upgraded Products
| e re—— e e r—

H Customer H
Key

‘ sz»fnzn\n@z, 5000 PT- 29549HQ. 5 56| CUS02266

1USER

We recommend that you print this screen for your records. Use the print friendly button on the left
An email has been sent to your email account with the above information.

Thank you for choosing ICONICS.

7. You should also receive an email with the license
upgrade information.

Upgrading a Hardware Key License

Upgrading a hardware key license is similar to upgrading the
software key license. You would follow the exact same
procedure as upgrading a software license. In the case of a
Hardware key License though, you will need the USB dongle
in order to kill the license from it and put the new one onto
the key.

Licensing the New Version

Now that you have upgraded the license, you can follow the
regular procedure to license your machine with the new
version. When it asks you for the Product Registration
Number and the Customer Key, you can provide the same
one. This information was sent to you in the last step of
upgrading your license via email. If you need more
information on how to license the machine with the upgraded
license, please consult our application notes titled Licensing
— Using the ICONICS Web License Ultility for Software Key
Licenses and Licensing — Using the ICONICS Web License
Utility for Hardware Key Licenses, as it pertains to your
individual situation. These Application Notes and more can
be found via the Info Center on the AnalytiX DVD.

ICONICS
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4.5 Cloud Licensing

4.5.1

4.5.2

How Cloud Licensing Works

ICONICS Cloud Licensing is a means of licensing ICONICS
products that is specifically designed for applications running
on public cloud, private cloud, or virtualized environments.
Rather than maintaining the license locally on the machine,
licenses are hosted by ICONICS on a publicly-accessible
data center.

During normal operations of the licensed machine, the first
action it takes when starting up is to request the license
information according to its License Pool ID. This request
requires the machine to have access to the internet in order
to request the information from the ICONICS cloud licensing
server.

Once the license information has been successfully
retrieved, the machine continues to operate using the
licensing information retrieved from the web. The machine
then periodically checks with the ICONICS Cloud Licensing
server in order to validate the license. If it cannot validate the
license for an extended period of time, the machine license
will fail.

Issuing a New Cloud License

Follow these instructions to activate a license on a machine
that currently has no license on it, or has a license on it that
you want to overwrite.

If your machine already has a license on it and you are
looking to add another license to it, see the next section
entitled, “Adding to an Existing Cloud License”.

1.  Go to http://www.iconics.com/support and click the
“License Your Product” link on the right.

2. Inthe new page that appears, select “Cloud” and log in
with your username and password.

4-28
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Note: If you do not have a username and password pair, you
can register for one using the “Create New Account” link at
the bottom of the window. If you have a username and
password but have forgotten them, you can click on the
“Forgot Password” link at the bottom of the window.

3. Once you have logged into the website, click on the
“New License” link at the top.

4. Enter your Product Registration Number(s) and
Customer Key(s) for the products.

Note: Your Product Registration Number(s) and Customer
Key(s) are usually inside the DVD tin package that ICONICS
sent when the product was purchased.

5. Click the “Next” button once you have entered all of
your Product Registration Number(s).

6. Choose an existing end user or enter new end user
information. Click “Next” when done.

Note: The existing end user dialog may take a few moments
to appear. Please be patient.

7. On the next screen, you see a list of the products that
are available for you to license. Check all the products
that you would like to license on this machine. Click
“Next”.

8. This page shows you a summary of what is in your license.
Check to make sure everything is correct, then click on the
“Generate Key” button. A page similar to the following image
appears.
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New License
ctivation.

n license ai
Canfiguration
uroses.

[ you
Pool inside 1CONICS Platform
0 the License Pool for future ref

License Pool: AG4F9EF1 D269 4386 A34D 63 7CDABI7ADD

Registered Products

|omrm‘ Order & P Humber |N s H ‘““‘:’,’”“H v e "
= cusazace s |

5351 HQ | PN1264CBE08EAECF 41 235 105

Thank vau for choosing 100NICS,

453 Activating the License

1. Open the “Platform Services Configuration” application
by going to Start > Programs > ICONICS > Tools >
Platform Services Configuration.

2. Select the “License” tab.

3. Select the radio button for “Cloud License” and enter
the “License Pool” code that was provided by the Web
License Utility. You can leave the “Password” blank.

4. Restart the FrameWorX64 Service.

4.5.4 Adding an Existing Cloud License

1. Go to http://www.iconics.com/support and click the
“License Product” link on the right.

2. Inthe new page that appears, select Cloud and log in
with your user name and password.

3. Once you have logged into the website, click on the
“Add to License” link at the top.

Note: It is very important to pick “Add to License” and not

“New License”. Picking “New License” overwrites any

existing license already activated on this machine. Make

sure to pick “Add to License” if you are adding products to a

machine that already has a license on it.

4.  Enter your existing License Pool ID and the Product
Registration Number(s), and Customer Key(s) for the
new products.
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4.5.5

Note: Your Product Registration Number(s) and Customer
Key(s) are usually inside the DVD tin package that ICONICS
sent when the product was purchased.

5.

6.

Click the “Next” button once you have entered all of
your Product Registration Number(s).

Choose an existing end user or enter new end user
information.

Click “Next” when done.

Note: The existing end user dialog may take a few moments
to appear. Please be patient.

7.

In the next screen, you see a list of the products that
are available for you to license. Check all the products
that you would like to license on this machine.

Click “Next”.

This page shows you a summary of what is in your
license. Check to make sure everything is correct, then
click on the “Generate Key” button.

Killing a Cloud License

1.

2.

Go to http://www.iconics.com/support and click the
“License Product” link on the right. Select the “License”
tab.

In the new page that comes up, select “Cloud” and log
in with your username and password.

3. Once you have logged into the website, click on the “Kill
License” link at the top. A page similar to the following figure
appears.

ICONICS
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Kill License

Please enter the License Pool to be removed and credited.

License Pool:

To remove a Cloud License for GENESIS64, do the following

1. dlick on Sta
2. click the Li
3. Enter your

Pragrams, ICONICS, Tools, Platform Services Configuration
& tab and copy the License ool
ense Pool into the text box above; then click the Remove Pool button.

4.  Enter your License Pool ID into the prompt.

Click “Remove Pool”.

5. A message confirming that the license has been
successfully removed appears. You will also receive an
email with the killed license information. The products
associated with this License Pool are now safely parked
on the website and available to be re-licensed at any
time.

4.6 Demo Mode

Without a valid license installed in your PC, it is still possible
to use AnalytiX in Runtime mode. The software will check for
a valid hardware or software license key on initialization. If
none is found, GENESIS64 runs in Demo Mode, which limits
you to:

e  Twelve hours of runtime
. Only 64 OPC tag connections (points) can be updated

Running AnalytiX longer than the 12-hour limit generates a
message stating that the demo time has been exceeded.
You must then exit AnalytiX and reboot the PC. On restarting
AnalytiX, you will get another 12-hour block of time in which
to run. If there are more than 64 tags on a particular screen,
gray keys (or whatever is configured as the Point Failure
character) will appear in place of the actual I/O data.
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5.1 Help Documentation

ICONICS software provides online help with descriptions
and explanations of each application. Help is available
throughout ICONICS Suite. You can access help in the
following ways:

. Click the Help 9 icon in the Workbench. This opens
the help file for that application. To search for a topic in
the help file, click the Index tab or the Search tab. Type
or select the term you want to find, and then click the
topic you want to read.

. Press the F1 key to display context-sensitive help.

. Click the Help button in any dialog box to display
context-sensitive help for that dialog box.

. Move the mouse pointer over an icon and pause for a
moment to display pop-up ToolTips for quick help.

. From the Windows Start menu, select All Programs >
ICONICS Help > Help

5.2 Product Videos

A new feature of the Customer Connection Portal is the in-
depth training videos highlighting many ICONICS products.
These videos help users configure their systems using best
practices. Starting with a Quick Start series introducing each
module in GENESIS64, these videos provide brief overviews
and demonstrations of how to use ICONICS products. Send
us your suggestion for topics to cover!

5.3 Training Classes

Training classes are held regularly at the ICONICS training
facility in Foxborough, Massachusetts. To reserve seats in
training courses and to view the current ICONICS training
schedule, go to http://www.iconics.com/Training.aspx. If you
have any questions about ICONICS training, please contact
our training coordinator at 508-543-8600.
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5.4 Technical Support

5.4.1

5.4.2

ICONICS customers may obtain technical support in several
different ways. First-line Support is through your local
ICONICS representative or distributor. You may also contact
ICONICS’ Support Engineers directly by phone, email or the
Customer Connection Portal
(https://getconnected.iconics.com).

For complete information about Global Technical Support,
please see the Global Support and Services User Guide at
http://www.iconics.com/supportworx.

Global Support and Services

ICONICS is proud to provide our customers with the highest
quality customer service. Our Global Support and Services
programs are supported by ICONICS offices around the
globe and our network of sales channel distributors and
representatives, with local and regional locations for front-
line service and expert assistance. Programs include the
SupportWorX™ Technical Support Services subscription
program for continuous technical support; Quality
Professional Services for expert system architecture
design assistance, training and start-up assistance; a 24 x 7
Emergency Support Option plan; and Training and
Certification programs for ICONICS users, systems
integrators and sales channels.

For complete information about SupportWorX service plans
and technical support, please see the Global Support and
Services User Guide at:
http://www.iconics.com/supportworx.

Customer Connection Portal

Get connected with ICONICS by visiting the Customer
Connection Portal for general support, product downloads,
product updates, customer collaboration and product tips
from ICONICS’ engineers and support team. The Customer
Connection Portal features Support Solutions, a Support
Bulletin, product videos, app notes, and whitepapers. The
Support Solutions section addresses essential questions
through the FAQ, Licensing, and a Global Search Engine,
enabling users to find answers quickly and easily.

5-2
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The Support Bulletin lists your support cases with real-time
status updates along with popular knowledgebase articles
and the most active forum threads. If users are current on
their SupportWorX software maintenance plan, they are
entitled to free upgrades. Download the latest product
updates and new product releases from the Customer
Connection Portal or sign up for the Beta program to try
select features before they are officially released

5.4.3 Telephone Support

ICONICS support centers are open Monday through Friday,
year round, except for local holidays and ICONICS holidays.
Support handles calls on a first-come, first-served basis
during the business hours below.

Americas (United States): 8:00 AM - 6:00 PM

1-508-543-8600 Eastern Standard Time

Europe (Czech Republic): 9:00 AM - 5:00 PM

+ 420-377-183-420 European Central Time

Asia Pacific (Australia): 9:00 AM - 5:00 PM

+ 61-2-9605 1333 Australian Eastern Time

Please have the following available when you call:

. Your SupportWorX Plan Number.

e A PC available for tests and diagnostics.

e Aclear understanding about the issue.

e  The version of your OS and the ICONICS product(s).
. OPC server or relevant third-party software info.

Note: Go to
https://getconnected.iconics.com/ICONICS/Support/GetSupp
ort.aspx to contact our Technical Support department.
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Email Support

The ICONICS support center email addresses are:

. North America: Support@ICONICS.com

. Europe: EuropeSupport@ICONICS.com

. Pacific Rim: PacificRimSupport@ICONICS.com

Please include your SupportWorX Plan Number when
sending your message. Email requests will be answered on
a first-come, first-served basis typically the same day.
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Global Support Offices

Americas
+1 508 543 8600

¥ support@iconics.com

Asia Pacific
+612 9605 1333

¥ pacificrimsupport@iconics.com

Europe
+420 377 183 420 (Czech Republic)
+49 2241 16 508 0 (Germany)

¥ europesupport@iconics.com

To open a support case, please visit
’P our Customer Connection Portal at % ’
getconnected.iconics.com.

For more, visit www.iconics.com

© 2019 ICONICS, Inc. All rights reserved. Specifications are subject to change
without notice. AnalytiX and its respective modules are registered trademarks A GrOUP Company of
of ICONICS, Inc. GENESIS64, GENESIS32, Hyper Historian, BizViz, PortalWorX, MltSUbIShI Electric

MobileHMI and their respective modules, OPC-to-the-Core, and Visualize Your
Enterprise are trademarks of ICONICS, Inc. Other product and company names

mentioned herein may be trademarks of their respective owners.
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